Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other equipment.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any Epson product. While some countries’ laws permit limited copying or reuse of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. Contact your legal advisor for any questions regarding copyright law.

Trademarks

Epson, Epson Stylus, Epson UltraChrome, and Epson UltraChrome Hi-Gloss are registered trademarks, and Epson Exceed Your Vision is a registered logomark of Seiko Epson Corporation.

UltraSmooth, Piezo Pro, RPM, and Radiance are registered trademarks, and Supplies Central and Epson Connection are service marks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.

The contents of this manual are subject to change without notice.

© 2009 Epson America, Inc. 4/09
## Contents

**Loading Paper** ................................................................. 6  
Loading Paper in the Sheet Feeder ........................................... 6  
Loading Paper Using the Single Sheet Guide ............................ 8  
Loading Roll Paper ............................................................... 10  
Available Epson Papers ......................................................... 13

**Printing From Start to Finish** .............................................. 16  
Printing in Windows .............................................................. 16  
Printing With a Macintosh ....................................................... 19  
Selecting the Correct Paper Type ............................................ 22

**Managing Color With Profiles** ............................................. 23  
Windows Printing With a Color Profile .................................... 23  
Macintosh Printing With a Color Profile .................................. 27

**Printing on CDs and DVDs** .................................................. 30  
Cleaning the Rollers .............................................................. 30  
Loading a CD or DVD ............................................................ 31  
Printing on a CD or DVD ....................................................... 32  
Removing Your Printed CD/DVD .............................................. 33

**Maintaining Your Printer** .................................................... 34  
Checking and Cleaning the Print Head ..................................... 34  
Checking and Aligning the Print Head ..................................... 35  
Checking the Ink Cartridge Status .......................................... 36  
Replacing Ink Cartridges ....................................................... 37
Solving Problems .......................................................... 41
Checking for Software Updates ........................................... 41
Checking the Printer Lights ............................................... 41
Problems and Solutions .................................................. 43
Where To Get Help ...................................................... 45

Notices. ................................................................. 46
**Introduction**

Your Epson Stylus® Photo R1900 Series printer gives you beautiful archival prints on a wide variety of glossy and matte papers in many sizes.

Your outstanding printouts result from these advanced features:

- Eight individual Epson UltraChrome Hi-Gloss® 2 ink cartridges, including red and orange inks for improved facial tones and increased vibrancy.
- Improved gloss optimizer cartridge provides a smooth, uniform glossy coat on glossy papers for an unprecedented look and feel.
- Enhanced media handling of sheets and rolls for virtually any kind of print up to 13 × 44 inches, with or without borders.
- Advanced Radiance™ technology for maximizing color gamut volume while providing smoother color transitions.
- Resolutions up to 5760 × 1440 optimized dpi (dots per inch) with 1.5 picoliter droplets for the finest details.
- Direct printing onto ink jet-printable CDs and DVDs for professional-looking labels.
- Two Hi-speed USB 2.0 ports for fast, easy connectivity to multiple computers.
- Downloadable premium ICC color profiles for precise color management.

Please follow these guidelines as you read the instructions on your Start Here sheet, User’s Guide book, and on-screen Reference Guide:

**Warning:**
Warnings must be followed carefully to avoid bodily injury.

**Caution:**
Cautions must be observed to avoid damage to your equipment.

**Note:**
Notes contain important information about your R1900 Series.

**Tip:**
Tips contain hints for better printing.
Loading Paper

You can print on a variety of paper sheets in the sheet feeder, or use the single sheet guide and manual feed slot for certain specialty papers (see page 8). For multiple photos, panoramics, and banners, load roll paper using the roll paper holders (see page 10).

Loading Paper in the Sheet Feeder

You can load the following paper types and quantities in the sheet feeder. Load other paper types in the manual feed slot using the single sheet feeder (see page 8).

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Maximum sheets by size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>120</td>
</tr>
<tr>
<td>Epson® Presentation Paper Matte</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>50 (B or Super B)</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>80</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>30 (all sizes)</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>30 (4 × 6 inch, 8 × 10 inch, Letter, 11 × 14 inch)</td>
</tr>
<tr>
<td></td>
<td>20 (5 × 7 inch)</td>
</tr>
<tr>
<td></td>
<td>10 (B, A3, Super B)</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>30 (4 × 6 inch, 8 × 10 inch, Letter)</td>
</tr>
<tr>
<td></td>
<td>20 (5 × 7 inch)</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>30 (Letter)</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>10 (A3 or Super B)</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>30 (4 × 6 inch or Letter)</td>
</tr>
<tr>
<td></td>
<td>10 (B)</td>
</tr>
</tbody>
</table>
1. Open the paper support and pull up the extensions, then open the output tray and pull out the extensions.

2. Insert paper, glossy or printable side up, short edge first, against the right side and beneath the tab. Then slide the edge guide against the paper.

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Maximum sheets by size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>30 (8 \times 10 \text{ inch or Letter})</td>
</tr>
<tr>
<td></td>
<td>10 (11 \times 14 \text{ inch, A3, or Super B})</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
</tr>
<tr>
<td>Double-sided</td>
<td>1 sheet</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td></td>
</tr>
</tbody>
</table>

Always load paper short edge first, even for landscape printing. Load letterhead or pre-printed paper top edge first.

**Note:**
The edge guide may move slightly during paper feeding and printing. Do not adjust the edge guide or open the printer cover during printing.
Loading Paper Using the Single Sheet Guide

You can print professional quality photos on these paper types using the single sheet guide and the manual feed slot:

- Epson Velvet Fine Art Paper
- Epson Watercolor Paper Radiant White
- Epson UltraSmooth® Fine Art Paper 250 gsm
- PremierArt™ Matte Scrapbook Photo Paper for Epson

(See page 13 for available sizes.)

1. Remove any paper from the sheet feeder and close the paper support.

2. Open the output tray and pull out the extensions.

3. Slide the roll paper edge guide on the back of the printer all the way to the right.

4. Attach the single sheet guide by aligning the notches on its base with the slots on the back of the printer. Then hook the tabs over the top of the slot (marked with orange triangles).

5. Turn on the printer so it can load the paper correctly.
6. Insert one sheet of paper, printable side up and against the right side, then slide the edge guide against the sheet, but not too tightly.

Note:
Load paper short edge first, no matter which way your photo faces. Check the paper package for any additional loading instructions.

7. Push the paper into the printer until it meets resistance and hold it there until the printer pulls it in slightly. Once the printer begins feeding the paper, let go of it.

8. Open the printer cover and make sure the paper has fed all the way into the printer and is straight. The paper must feed straight so the printer can properly identify the edge of it. If the paper is crooked or the front edge is visible, you may receive a paper jam error when you print. To avoid this, press and hold the \( \text{roll paper button} \) for three seconds to back the paper out. Press the \( \text{paper button} \) to clear the paper out error, then load the paper again.

9. Close the printer cover and do not open it during printing.
Loading Roll Paper

You can load roll paper or canvas media to print large, panoramic images or multiple photos, with or without borders.

You can load Epson roll paper in these widths:

- 8.3-inches wide
- 13-inches wide

(See page 13 for a list of roll paper and canvas media types and sizes.)

**Tip:**
It’s a good idea to check the ink status and replace cartridges, if necessary, before loading on roll paper (see page 36). This is because you must remove roll paper from the printer before replacing cartridges to avoid ink marks on the paper.

1. Turn on the printer.
2. Remove any paper loaded in the sheet feeder and remove the single sheet guide, if it is installed (see page 8). Also close the paper support.
3. Open the output tray, but do not pull out the extensions.
4. Place the roll paper holders on each end of the paper roll as shown.
5. Remove any tape and protective paper from the end of the roll and make sure the corners of the paper are cut at 90° angles to avoid paper feeding problems.
Note:
Avoid touching the surface of your paper or canvas media.

With canvas media that you have previously loaded, it’s a good idea to cut the edge straight each time you reload it.

6. Insert the left roll paper holder (marked with a down orange triangle) into the far left slot on the back of the printer (marked with a right orange triangle). Then insert the right roll paper holder in the corresponding slot on the right.

7. Feed the end of the paper into the roll paper feeder, located behind the roll and marked with the \(\mathbb{M}\) roll paper icon.

8. Slide the roll paper edge guide against the right side of the paper, but not too tightly.

Caution:
Do not load roll paper or canvas media into the manual feed slot (marked with up orange triangles).

9. Guide the paper into the slot and hold it for a few seconds until the printer feeds in the paper automatically.

Note:
When loading canvas media, leave two to three inches of slack in the roll as it feeds and prints for the best results. If you have trouble feeding canvas media, check that the edge is straight and reload it, making sure to keep the roll slack.
10. Open the printer cover and look into the printer to make sure the roll paper or canvas media is feeding straight. The paper must feed straight so the printer can properly identify the edge of it.

If it is crooked or the front edge is visible, you may receive a paper jam error when you print. To avoid this, press the roll paper button for three seconds to back the paper out. Press the paper button to clear the paper out error, then load the roll paper or canvas media again.

11. For roll paper, turn the knobs on the roll paper holders backward to remove excess slack. (Leave two to three inches of slack on canvas media.)

12. Close the printer cover and do not open it during printing.

**Removing Roll Paper Prints and Roll Paper**

1. To remove your roll paper or canvas media prints, press the roll paper button to feed the paper forward, then cut off your printed photos straight across the paper at the cutting guideline.

   **Caution:**
   Do not pull on the paper as you cut it to avoid damaging your printout. Also do not cut the paper too close to the printer to avoid paper feeding problems.

2. To continue printing on roll paper or canvas media, press the roll paper button again to return the paper to printing position.

3. If you are finished printing on roll paper or canvas media, press the roll paper button for three seconds to feed the paper backwards and out of the printer. If it does not feed all the way out, press the roll paper button again.

4. Turn the knobs on the roll paper holders backward to roll up the paper, then remove the paper and holders from the printer.

5. Press the paper button to stop the paper light from flashing.

Store the unused roll paper or canvas media in its original package away from high temperatures, humidity, and direct sunlight.
# Available Epson Papers

Epson offers a wide array of high quality papers, making it easy to maximize the impact of your photos, presentations, and creative projects.

You can purchase genuine Epson ink and paper at Epson Supplies Central™ at [www.epson.com/ink3](http://www.epson.com/ink3) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
<th>Sheet count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>4 × 6 inches</td>
<td>S041808/S041727</td>
<td>40/100</td>
</tr>
<tr>
<td></td>
<td>5 × 7 inches</td>
<td>S041464</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8 × 10 inches</td>
<td>S041465</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041286/S041667</td>
<td>20/50</td>
</tr>
<tr>
<td></td>
<td>11 × 14 inches</td>
<td>S041466</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>B (11 × 17 inches)</td>
<td>S041290</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 × 16.5 inches)</td>
<td>S041288</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Super B (13 × 19 inches)</td>
<td>S041289</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>8.3 inches × 32 feet</td>
<td>S041376</td>
<td>Roll</td>
</tr>
<tr>
<td></td>
<td>13 inches × 32 feet</td>
<td>S041378</td>
<td>Roll</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>4 × 6 inches</td>
<td>S041934</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041935</td>
<td>20</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>4 × 6 inches</td>
<td>S041809/S042038</td>
<td>50/100</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041141/S041649/S041271</td>
<td>20/50/100</td>
</tr>
<tr>
<td></td>
<td>B (11 × 17 inches)</td>
<td>S041156</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Super B (13 × 19 inches)</td>
<td>S041143</td>
<td>20</td>
</tr>
<tr>
<td>Paper name</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>-----------------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Epson Premium Photo Paper</td>
<td>4 x 6 inches</td>
<td>S041982</td>
<td>40</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041331</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041327</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Epson Ultra Premium Photo Paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041405</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 x 16.5 inches)</td>
<td>S041406</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041407</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>8.3 inches x 32.8 feet</td>
<td>S041408</td>
<td>Roll</td>
</tr>
<tr>
<td></td>
<td>13 inches x 32.8 feet</td>
<td>S041409</td>
<td>Roll</td>
</tr>
<tr>
<td></td>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041341</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 x 16.5 inches)</td>
<td>S041343</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041339</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10 inches</td>
<td>S041467</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041257</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>11 x 14 inches</td>
<td>S041468</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>A3 (11.7 x 16.5 inches)</td>
<td>S041260</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041263</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041568</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Epson Presentation Paper Matte</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 x 14 inches)</td>
<td>S041067</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>B (11 x 17 inches)</td>
<td>S041070</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041069</td>
<td>100</td>
</tr>
<tr>
<td></td>
<td>Epson Velvet Fine Art Paper</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041636</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041637</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Epson Watercolor Paper Radiant White</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041351</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Epson UltraSmooth Fine Art Paper 250 gsm</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Super B (13 x 19 inches)</td>
<td>S041896</td>
<td>25</td>
</tr>
<tr>
<td>Paper name</td>
<td>Size</td>
<td>Part number</td>
<td>Sheet count</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>PremierArt Matte Scrapbook Photo Paper for Epson</td>
<td>Letter (8.5 × 11 inches)</td>
<td>SCR1002</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>12 × 12 inches</td>
<td>SCR1003</td>
<td>10</td>
</tr>
<tr>
<td>PremierArt Water Resistant Canvas for Epson</td>
<td>13 inches × 20 feet</td>
<td>SP91220</td>
<td>Roll</td>
</tr>
<tr>
<td>Piezo Pro® Matte Canvas for Epson</td>
<td>13 inches × 20 feet</td>
<td>S041992</td>
<td>Roll</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041586</td>
<td>500</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>A4 (8.3 × 11.7 inches)</td>
<td>S041106</td>
<td>10</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td>Letter (8.5 × 11 inches)</td>
<td>S041153</td>
<td>10</td>
</tr>
</tbody>
</table>
Printing From Start to Finish

This section describes basic printing from your Windows® or Macintosh® computer. For detailed instructions, see the on-screen Reference Guide.

You can also print label designs directly onto ink jet-printable CDs or DVDs. See page 30 and the on-screen Reference Guide for details.

To print photos directly from a PictBridge-compatible digital camera connected to the R1900 Series, see the on-screen Reference Guide.

Tip:
It’s a good idea to check for updates to your Epson Stylus Photo R1900 Series software. See “Checking for Software Updates” on page 41 for instructions.

Printing in Windows

1. Open a photo or document in a printing program, open the File menu, and select Print.

![Printer software interface]

Select EPSON Stylus Photo R1900 Series

Click here to open your printer software

2. Select EPSON Stylus Photo R1900 Series and click the Preferences or Properties button.

Note:
If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties on the next screen.
3. On the Main tab, select one of the following as the Quality Option setting:
   - **Draft**: for rough drafts with reduced print quality
   - **Text**: for documents containing text or images with standard print quality
   - **Text & Image**: for documents with text or images with better print quality
   - **Photo**: for photos and graphics with good print quality and speed
   - **Best Photo**: for photos or graphics with high print quality

4. Choose the paper **Source** in which you loaded your paper:
   - **Sheet**: for sheets of paper loaded in the sheet feeder
   - **Roll**: for roll paper or canvas media loaded in the roll paper holder (see page 10 for loading instructions; see the on-screen Reference Guide for instructions on selecting roll paper options using the Settings button)
   - **Manual - Roll**: for a sheet of compatible paper loaded in the manual feed slot using the single sheet guide (see page 8 for loading instructions)
   - **CD/DVD**: for a disc loaded in the CD/DVD tray guide (see page 30 for printing instructions)

5. Choose the correct paper **Type** setting for your paper (see page 22).
6. Choose the size of the paper sheets you loaded as the **Size** setting.
For roll paper or canvas media, select the width of your roll as the Size setting. Select A4 for 8.3-inch rolls or Super B for 13-inch rolls.

**Note:**
For roll paper, make sure the maximum width of your photo is set to 8.3 or 13 inches to fit in the width of your roll paper.

7. To print borderless photos on compatible paper, select Borderless, if available.

8. To reduce or enlarge your printout, print double-sided, or adjust the borderless expansion setting, click the Page Layout tab and select settings as necessary. (Click Help or see your on-screen Reference Guide for details.)

9. For more printing options, click the Advanced tab.

10. Select a print quality setting (available settings depend on selected paper type):

   - Economy: for the fastest printing with reduced quality on plain paper
   - Normal: for everyday text and image printing
   - Draft: for the fastest photo printing with draft quality
   - Photo: for photos and graphics with good print quality and speed
   - Best Photo: for photos and graphics with high print quality and slower speed (good to use for canvas media)
   - Photo RPM®: for the best print quality and slowest print speed (best to use for canvas media)
Note:
For color management instructions, see page 23. For more information about print settings, click Help or see your on-screen Reference Guide.

11. Click OK to save your settings.

12. Click OK or Print to start printing.

This window appears and shows the progress of your print job.

Note:
If you’re printing on roll paper or canvas media, see page 12 for instructions on removing your printed photos and paper.

Printing With a Macintosh

1. Open a photo or document in a printing program, open the File menu, and select Page Setup.
2. Select the **Paper Size** setting for the paper size and source you are using:

- To print a borderless photo on paper loaded in the sheet feeder, select the paper size with a **Sheet Feeder - Borderless** option.

- To print on roll paper, select the size of your photo with a **Roll Paper** or **Roll Paper - Borderless** option. (To eliminate space between photos on certain sizes, select a **Roll Paper - Borderless Banner** option.)

  **Note:**
  For roll paper, make sure the maximum width of your photo is set to 8.3 or 13 inches to fit in the width of your roll paper.

- To print on paper loaded in the manual feed slot using the single sheet guide, select a paper size with a **Manual - Roll** or **Manual - Roll (Borderless)** option.

3. Select the orientation of your document or photo as the **Orientation** setting.

4. Click **OK**.

5. Open the **File** menu and select **Print**.

6. Select **Stylus Photo R1900**, choose **Print Settings** from the pop-up menu, and select the following print settings:

![Print Settings pop-up menu]

**Note:**
In certain programs, you may need to select **Advanced** before you can select **Print Settings**. For more information about print settings, click the ? button.

7. Select the **Media Type** setting for your paper (see page 22).

---

20 Printing From Start to Finish
8. Select Color or Grayscale output in the Color pop-up menu.

9. For basic printing, select Automatic as the Mode setting and move the Quality/Speed slider to select higher quality or faster print speed.

10. For more printing options, click the Advanced button.

11. Select a Print Quality setting (available settings depend on selected paper type):

■ Economy: for the fastest printing with reduced quality on plain paper
■ Normal: for everyday text and image printing
■ Draft: for the fastest photo printing with draft quality
■ Photo: for photos and graphics with good print quality and speed
■ Best Photo: for photos and graphics with high print quality and slower speed (good to use for canvas media)
■ Photo RPM: for the best print quality and slowest print speed (best to use for canvas media)

Note:
For color management instructions, see page 23. For more information about print settings, click ? or see your on-screen Reference Guide.

12. Click Print.

13. To monitor your print job, click the printer icon in the dock (or click the Print Center icon and double-click SP R1900 on the next screen).

Note:
If you’re printing on roll paper or canvas media, see page 12 for instructions on removing your printed photos and paper, if necessary.
## Selecting the Correct Paper Type

Select the correct **Type** (see page 17) or **Media Type** (see page 20) setting in your printer software so the ink coverage can be adjusted for your media.

<table>
<thead>
<tr>
<th>For this paper/media</th>
<th>Select this setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epson Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Glossy</td>
<td>Premium Photo Paper Glossy</td>
</tr>
<tr>
<td>Plain paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Bright White Paper</td>
<td>Plain Paper/Bright White Paper</td>
</tr>
<tr>
<td>Epson Photo Paper Glossy</td>
<td>Photo Paper Glossy</td>
</tr>
<tr>
<td>Epson Presentation Paper Matte</td>
<td>Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Premium Photo Paper Semi-gloss</td>
<td>Premium Photo Paper Semi-Gloss</td>
</tr>
<tr>
<td>Epson Ultra Premium Photo Paper Luster</td>
<td>Ultra Premium Photo Paper Luster</td>
</tr>
<tr>
<td>PremierArt Water Resistant Canvas for Epson*</td>
<td>Ultra Premium Photo Paper Luster</td>
</tr>
<tr>
<td>Epson Ultra Premium Presentation Paper Matte</td>
<td>Ultra Premium Presentation Matte</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte</td>
<td>Ultra Premium Presentation Matte</td>
</tr>
<tr>
<td>Piezo Pro Matte Canvas for Epson*</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Photo Quality Self-adhesive Sheets</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Iron-on Cool Peel Transfer Paper</td>
<td>Premium Presentation Paper Matte</td>
</tr>
<tr>
<td>Epson Velvet Fine Art Paper</td>
<td>Velvet Fine Art Paper</td>
</tr>
<tr>
<td>Epson Watercolor Paper Radiant White</td>
<td>Watercolor Paper - Radiant White</td>
</tr>
<tr>
<td>Epson UltraSmooth Fine Art Paper 250 gsm</td>
<td>UltraSmooth Fine Art Paper</td>
</tr>
<tr>
<td>PremierArt Matte Scrapbook Photo Paper for Epson</td>
<td>UltraSmooth Fine Art Paper</td>
</tr>
<tr>
<td>Epson Premium Presentation Paper Matte Double-sided</td>
<td>Double-Sided Matte Paper</td>
</tr>
<tr>
<td>Ink jet-printable CD or DVD</td>
<td>CD/DVD</td>
</tr>
<tr>
<td></td>
<td>CD/DVD Premium Surface</td>
</tr>
</tbody>
</table>

* For the best results on this paper, print using a premium ICC profile, downloadable from Epson at http://www.epson.com/SPR1900Profiles.
Managing Color With Profiles

For the most precise color in your prints, you can use profiles designed specifically for your printer model and paper type. Basic profiles are installed with your printer driver, and you may also have downloaded Premium ICC profiles from Epson when you installed your printer software.

Follow the instructions in this chapter to use Adobe® Photoshop® 7, CS, CS2, or CS3 to print with profiles using Photoshop color management (the steps show only CS3 screens). For additional details, see the on-screen Reference Guide.

**Note:**
It's important to turn off color management in your printer software when you use Photoshop color management or you’ll get unexpected results.

See these sections for instructions:

- “Windows Printing With a Color Profile” below
- “Macintosh Printing With a Color Profile” on page 27

**Note:**
Assigning a profile to your image doesn’t alter it, only the interpretation of it by your software and how it appears on your monitor and in a printout. This is the best way to improve the color balance and contrast in your image.

---

Windows Printing With a Color Profile

First set up your color management environment in Photoshop and assign a profile to your image, then select your print settings and print.

**Setting Up Photoshop and Assigning a Profile**

1. Open Photoshop.
2. Select Color Settings from the Edit menu.
You see this window:

3. Select U.S. Prepress Defaults or North America Prepress 2 from the Settings menu to set Adobe RGB (1998) as the color space. Click OK.

4. Open the photo you want to print.
   
   If you see an Embedded Profile Mismatch message, select Use the embedded profile and click OK.
   
   If you see a Missing Profile message, select Assign working RGB: Adobe RGB (1998) and click OK.

5. When your image appears, evaluate the color balance and contrast. If they need improvement, select Image > Mode > Assign Profile or Edit > Assign Profile. Then select one of the following as the Profile setting:
   
   ■ A different RGB working space (or Profile), such as ColorMatch RGB or sRGB IEC61966-2.1
   
   ■ A scanner profile for your scanner
   
   ■ A camera profile for your digital camera
   
   Click the Preview box to see the effects of your profile choice on the screen.

6. Select Page Setup from the File menu, select your page settings, and click OK.

24 Managing Color With Profiles
7. Select **File**, then select **Print** or **Print with Preview**.

8. If necessary, click **More Options** or **Show More Options**, then select **Color Management**.

9. Under **Color Handling**, select **Let Photoshop Determine Colors** or **Photoshop Manages Colors**.

10. Under **Profile** or **Printer Profile**, select a profile for your printer and the paper you'll use. If you're printing with Epson Premium ICC profiles, select the profile that also matches the print quality you want to use, such as **SPR1900 PrmGlsy BstPhoto.icc**.

11. For the **Intent** or **Rendering Intent** setting, select **Relative Colorimetric** and click the **Black Point Compensation** checkbox.

   **Note:**
   If your image contains very saturated colors, select **Perceptual**. This reduces the color saturation so that the colors fit within the printer's color gamut.
Selecting Print Settings and Printing

1. Click the Print button, select your printer, and click Properties or Preferences.

2. Click the Advanced tab.

3. If you are using an Epson Premium ICC profile, set the print quality setting to match your profile.

4. Select the Type setting for your paper (see page 22).

5. Turn off the High Speed and Edge Smoothing options, if available.

6. Select the ICM button under Color Management, then check the Off (No Color Adjustment) box.

   **Note:**
   Make sure that you select Off (No Color Adjustment). If you don’t, the printer driver will apply additional correction to the image data, producing inaccurate results.

7. If you are printing on any of the following glossy media, make sure the Gloss checkbox is selected:
   - Ultra Premium Photo Paper Glossy
   - Premium Photo Paper Glossy
   - Premium Photo Paper Semi-gloss
   - Ultra Premium Photo Paper Luster
   - PremierArt Water Resistant Canvas

8. Click OK, then click OK or Print to print your photo.

   **Note:**
   If you selected the wrong combination of source profile, printer profile, and color management settings, you’ll get unexpected results. If your printed image is darker than expected and/or has a strong yellow-brown cast, you probably turned off color management in both Photoshop and the Epson printer driver. If your printed image is lighter than expected and/or has a strong light blue cast, you probably turned on color management in both Photoshop and the Epson printer driver.
Macintosh Printing With a Color Profile

First set up your color management environment in Photoshop and assign a profile to your image, then select your print settings and print.

Setting Up Photoshop and Assigning a Profile

1. Open Photoshop.
2. Select Color Settings from the Photoshop or Edit menu. You see this window:

3. Select U.S. Prepress Defaults or North America Prepress 2 from the Settings menu to set Adobe RGB (1998) as the color space. Click OK.
4. Open the photo you want to print.
   
   If you see an Embedded Profile Mismatch message, select Use the embedded profile and click OK.
   
   If you see a Missing Profile message, select Assign working RGB: Adobe RGB (1998) and click OK.
5. When your image appears, evaluate the color balance and contrast. If they need improvement, select Image > Mode > Assign Profile or Edit > Assign Profile.
Then select one of the following as the Profile setting:

- A different RGB working space, such as ColorMatch RGB or sRGB IEC61966-2.1
- A scanner profile for your scanner
- A camera profile for your digital camera

Click the Preview box to see the effects of your profile choice on the screen.

6. Select File, then click Print or Print with Preview.

7. If necessary, click More Options or Show More Options, then select Color Management.

8. Click Page Setup, select page settings as necessary, and click OK.

9. Under Color Handling, select Let Photoshop Determine Colors or Photoshop Manages Colors.

10. Under Profile or Printer Profile, select a profile for your printer and the paper you'll use. If you're printing with Epson Premium ICC profiles, select the profile that also matches the print quality you want to use, such as SPR1900 PrmGlssy BstPhoto.icc.

11. As the Intent or Rendering Intent setting, select Relative Colorimetric and click the Black Point Compensation checkbox.

**Note:**
If your image contains very saturated colors, select Perceptual. This reduces the color saturation so that the colors fit within the printer's color gamut.
Selecting Print Settings and Printing

1. Click the Print button, select Stylus Photo R1900, and select Print Settings.

2. Select the Media Type setting for your paper (see page 22).

3. Click the Advanced button.

4. If you are using an Epson Premium ICC profile, set the Print Quality setting to match your profile.

5. If you are printing on any of the following glossy media, make sure Gloss Optimizer is set to On:
   - Ultra Premium Photo Paper Glossy
   - Premium Photo Paper Glossy
   - Premium Photo Paper Semi-gloss
   - Ultra Premium Photo Paper Luster
   - PremierArt Water Resistant Canvas

6. Turn off the High Speed option.

7. Select Color Management, then select Off (No Color Adjustment).
   **Note:**
   Make sure that you select Off (No Color Adjustment). If you don’t, the printer driver will apply additional correction to the image data, producing inaccurate results.

8. Click Print to print your photo.
   **Note:**
   If you selected the wrong combination of source profile, printer profile, and color management settings, you’ll get unexpected results. If your printed image is darker than expected and/or has a strong yellow-brown cast, you probably turned off color management in both Photoshop and the Epson printer driver. If your printed image is lighter than expected and/or has a strong light blue cast, you probably turned on color management in both Photoshop and the Epson printer driver.
Printing on CDs and DVDs

You can use your R1900 Series and the Epson Print CD software that came with it to print label designs directly onto ink jet-printable CDs or DVDs.

Before you load a CD or DVD, be sure to clean the rollers inside the printer, as described below. Also burn files, music, or video onto your CD or DVD before printing on it to prevent errors.

Then follow the steps in these sections:

■ “Loading a CD or DVD” on page 31
■ “Printing on a CD or DVD” on page 32
■ “Removing Your Printed CD/DVD” on page 33

Note:
If you’re using discs where the printable area extends to within 0.16 inch (4 mm) of the edge of the center hole, you may need to adjust the Inner Diameter setting in the File menu of the Epson Print CD software. See the program’s Help utility for instructions.

Cleaning the Rollers

Before you print on a CD or DVD, it’s a good idea to clean the rollers inside the printer by feeding several sheets of plain paper through it.

1. Turn on the printer.
2. Load several sheets of plain paper in the sheet feeder (see page 6).
3. Press the paper button to feed the paper through the printer.
4. Press the paper button again to eject the paper.
5. Feed several sheets of paper in this way to completely clean the rollers.
Loading a CD or DVD

1. First burn files, music, or video onto your CD or DVD before printing on it to prevent errors.
2. Turn on the printer.
3. Clean the rollers inside the printer (see page 30).
4. Remove any paper loaded in the sheet feeder and remove the single sheet guide, if it is installed. Also close the paper support.
5. Open the output tray, but do not pull out the extensions. Then open the CD/DVD tray guide cover.

6. Place your disc on the CD/DVD tray with the label side up.

Note:
For small 8-cm discs, place the adapter on the tray and then place the disc in the adapter.
7. Insert the CD/DVD tray into the tray guide and slide it into the printer beneath the guide rails until the arrows are aligned.

When you send your CD/DVD print job to the printer, it automatically places the disc in the correct print position and ejects it automatically when printing finishes.

**Caution:**
Do not turn the R1900 Series on or off with a CD or DVD loaded in it. Always remove the disc first (see page 33).

---

**Printing on a CD or DVD**

When you installed the software for the R1900 Series, you installed the Epson Print CD program for printing label designs directly onto CDs or DVDs. Follow these steps to open the program and print on the disc you loaded in the printer:

1. Do one of the following to start Epson Print CD:

   **Windows:** Double-click the EPSON Print CD icon on your desktop.
   
   **Macintosh:** Open the Applications folder, open the EPSON Print CD folder, and double-click EPSON Print CD.
2. Follow the instructions in the on-screen Reference Guide to design your disc label. You can use the tools on the screen to add text and provided background designs, or add your own designs or photos.

3. When you’re ready to print on the disc, open the File menu and select Print. You see one of these windows:

4. Select EPSON Stylus Photo R1900 Series (Windows) or Stylus Photo R1900 (Macintosh), if necessary.

5. Click Print.

Removing Your Printed CD/DVD

After your CD or DVD is printed, the tray ejects partially from the R1900 Series. Pull out the tray and remove the disc.

Caution:
Do not turn the R1900 Series on or off with a CD or DVD loaded in it. Always remove the disc first.

After printing, handle the printed CD or DVD carefully. You may need to wait up to 24 hours for the ink to dry fully before inserting it in a drive. Keep printed discs away from moisture and direct sunlight.

If you need to adjust the print position or print quality, see your on-screen Reference Guide for instructions.
Maintaining Your Printer

Follow the steps in these sections to keep the R1900 Series working at its best:

- “Checking and Cleaning the Print Head” below
- “Checking and Aligning the Print Head” on page 35
- “Checking the Ink Cartridge Status” on page 36
- “Replacing Ink Cartridges” on page 37

Checking and Cleaning the Print Head

You can check and clean the print head nozzles automatically using the Auto Nozzle Check and Cleaning utility in your printer software. It prints a check pattern that your printer then reads to see if you have any clogged nozzles, which it then cleans, if necessary.

1. Load a few sheets of plain paper in the sheet feeder (see page 6).
2. Do one of the following:
   - **Windows**: Right-click the icon in the bottom right corner of your screen (the taskbar) and select Auto Head Cleaning.
   - **Macintosh**: Open the Applications folder, open the EPSON Printer Utility2, select SP R1900, and click OK. Then select Auto Head Cleaning.
3. Click Start and follow the on-screen instructions to allow the printer to print and examine the nozzle check pattern. If necessary, the printer cleans the print head, and may print and check the nozzle check pattern a few times.

   If nozzles are still clogged, you see a message telling you to clean the print head manually. See the on-screen Reference Guide for instructions.
Note:
If you don’t see any improvement after cleaning the print head four times, turn off your printer and wait at least six hours to let any dried ink soften. Then try printing again.

If you do not use your R1900 Series often, it is a good idea to print a few pages at least once a month to maintain good print quality.

Checking and Aligning the Print Head

If your printouts become grainy or blurry, or you see dark or light bands across them, you may need to align the print head.

It’s best to run the automatic alignment utility first to let the printer check and align the print head, if necessary. If you still notice alignment problems, you can align the print head manually.

Note:
Banding may also occur if your print head nozzles need cleaning (see page 34).

1. Load a few sheets of Epson Presentation Paper Matte (or the photo paper you have on hand) in the sheet feeder (see page 6). It’s best to use matte or photo paper for the most accurate alignment.

2. Do one of the following:
   
   **Windows**: Right-click the icon in the bottom right corner of your screen (the taskbar) and select Print Head Alignment.
   
   **Macintosh**: Open the Applications folder, open the EPSON Printer Utility2, select SP R1900, and click OK. Then select Print Head Alignment.

3. To have the printer check and align the print head automatically, click Automatic, then click OK. Follow the on-screen instructions to print the alignment check patterns and align the print head as necessary.

To align the print head manually, click the Manual button and follow the on-screen instructions, or see the on-screen Reference Guide for detailed steps.
Checking the Ink Cartridge Status

Your R1900 Series will let you know when an ink cartridge is low or expended in the following ways:

■ The Δ ink light flashes when ink is low in one or more cartridges.
■ The Δ ink light stays on when an ink cartridge is expended.
■ Your computer screen displays a message when you try to print. This window can optionally display ink offers and other updates retrieved from an Epson website.

Note:
On a Windows computer that is connected to the Internet, you may see a screen asking if you want to receive Epson offers the first time you try to print when ink is low. Click Accept or Decline. To disable checking for ink offers or updates from Epson, see the instructions in your on-screen Reference Guide.

You cannot print when an ink cartridge is expended even if the other cartridges are not expended. Replace any expended cartridges before printing.

To check the ink cartridge status at anytime, do one of the following:

Windows:
Double-click the icon in the bottom right corner of your screen (the taskbar).
You see the screen to the right.

Macintosh:
1. Open the Applications folder.
2. Open the EPSON Printer Utility2.
3. Select SP R1900, click OK, and select EPSON StatusMonitor.
   You see the screen to the right.
Replacing Ink Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).

Use the following list when you order or purchase new ink cartridges:

<table>
<thead>
<tr>
<th>Ink color or cartridge type</th>
<th>Part number</th>
<th>Part number on software screens</th>
</tr>
</thead>
<tbody>
<tr>
<td>Photo Black</td>
<td>87</td>
<td>T0871</td>
</tr>
<tr>
<td>Matte Black</td>
<td>87</td>
<td>T0878</td>
</tr>
<tr>
<td>Cyan</td>
<td>87</td>
<td>T0872</td>
</tr>
<tr>
<td>Magenta</td>
<td>87</td>
<td>T0873</td>
</tr>
<tr>
<td>Yellow</td>
<td>87</td>
<td>T0874</td>
</tr>
<tr>
<td>Red</td>
<td>87</td>
<td>T0877</td>
</tr>
<tr>
<td>Orange</td>
<td>87</td>
<td>T0879</td>
</tr>
<tr>
<td>Gloss Optimizer</td>
<td>87</td>
<td>T0870</td>
</tr>
</tbody>
</table>

Note:
We recommend that you use genuine Epson cartridges and do not refill them. The use of other products may affect your print quality and could result in printer damage.

Yields vary considerably based on images printed, print settings, paper type, frequency of use, and temperature. For print quality, a small amount of ink remains in the cartridge after the “replace cartridge” indicator comes on. The printer ships with full cartridges and part of the ink from the first cartridges is used for priming the printer.

For best printing results, use up a cartridge within six months of opening the package.

Caution:
Do not open ink cartridge packages until you are ready to install the ink. Cartridges are vacuum packed to maintain reliability.

Leave your old cartridges in the R1900 Series until you are ready to replace them to prevent the print head nozzles from drying out.

Remove the CD/DVD tray before replacing ink cartridges.
Make sure you have a new ink cartridge before you begin. You must install new cartridges immediately after removing the old ones.

1. Remove any roll paper or canvas media loaded in the printer to prevent ink marks on the paper (see page 12).

2. Open the printer cover.

3. Press the △ ink button to move the print head to the ink replacement position. If a cartridge is low or expended, the light above the cartridge flashes or stays on.

   ![Image of ink button]

   **Caution:**
   Don’t move the print head by hand or touch the flat white cable behind the print head to avoid damaging your printer.

4. Open the cartridge cover.

   ![Image of cartridge cover]

5. Squeeze the tab on the cartridge and lift the cartridge straight up to remove it. Dispose of it carefully. Do not take the used cartridge apart or try to refill it.

   **Warning:**
   If ink gets on your hands, wash them thoroughly with soap and water. If ink gets into your eyes, flush them immediately with water. Keep ink cartridges out of the reach of children.
6. Before opening the cartridge package, shake the package four or five times.

   **Note:**
   All cartridges, except the gloss optimizer cartridge, make a clicking sound when you shake them.

   ![Image showing shaking a cartridge]

   **Caution:**
   Do not shake the cartridges after opening the packages or ink will leak.

7. Remove the cartridge from the package, but be careful not to touch the green chip on the cartridge.

8. Remove the yellow tape from the bottom of the cartridge.

   ![Image showing removing the yellow tape]

   **Caution:**
   Do not remove any other labels or seals, or ink will leak.

9. Insert the new cartridge into the holder and push it down until it clicks into place.

   ![Image showing inserting a cartridge]
10. Once you replace all the necessary cartridges, close the cartridge cover and push it down until it clicks into place.

11. Close the printer cover.

12. Press the \( \text{△} \) ink button to begin charging the ink. This takes about 2 1/2 minutes. The \( \text{◯} \) power light flashes as the ink charges.

When the \( \text{◯} \) power light stops flashing and the \( \text{△} \) ink light goes out, ink charging is finished.

**Caution:**
Never turn off the R1900 Series while ink is charging or you’ll waste ink.

If the \( \text{△} \) ink light is flashing, press the \( \text{△} \) ink button, then press down all the cartridges securely.

If you remove a low or expended ink cartridge, you cannot reinstall and use the cartridge.
Solving Problems

Check the status of the printer lights to diagnose the cause of most problems (see below), or check the solutions beginning on page 43 for more information.

Open your on-screen Epson Information Center for detailed help and easy access to Epson’s support website, FAQs, paper and ink purchasing, and Reference Guide.

Checking for Software Updates

Periodically, it’s a good idea to check Epson’s support website for free updates to your Epson Stylus Photo R1900 Series software. Open your on-screen Epson Information Center and select Download the Latest Software or visit Epson’s support website at epson.com/support (U.S.) or epson.ca (Canada).

With Windows, you can select Driver Update on the Maintenance tab in the printer settings window. You can also click Start or , select Programs or All Programs, select EPSON, and click EPSON Stylus Photo R1900 Series Driver Update.

Checking the Printer Lights

Check the status of the printer lights to solve the most common problems.

<table>
<thead>
<tr>
<th>Light status</th>
<th>Problem and solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄 paper on</td>
<td>Paper may be out or multiple sheets may have fed into the sheet feeder. Load paper, if necessary (see page 6), and press the 🔄 paper button. Roll paper or canvas media may be out. See page 10 to load roll paper. The CD/DVD tray may not be inserted. See page 31 to load a CD or DVD.</td>
</tr>
<tr>
<td>Light status</td>
<td>Problem and solution</td>
</tr>
<tr>
<td>--------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>🟢 paper flashing</td>
<td>Paper may have jammed in the sheet feeder, manual feed slot, or roll paper slot. <strong>Sheet Feeder or Manual Feed Slot:</strong> Press the 🟢 paper button to eject any jammed sheets, then open the printer cover and remove any paper jammed inside. Press the 🟢 paper button again to clear the error. <strong>Roll Paper Slot:</strong> Cut off any printed roll paper or canvas media, then remove (see page 12) and reload (see page 10) the paper. The CD/DVD tray may be unable to eject. Gently pull out the CD/DVD tray and press the 🟢 paper button. See page 31 to reload the tray. The printer cover may be open. Close the printer cover to continue. (Leaving the printer cover open stops or prevents printing.)</td>
</tr>
<tr>
<td>🔴 ink on</td>
<td>An ink cartridge is expended or not installed correctly, or is not compatible with the printer. Replace or reinstall the cartridge (see page 37).</td>
</tr>
<tr>
<td>🔴 ink flashing</td>
<td>Ink in a cartridge is low. You can continue printing, or check which cartridge is low (see page 36) and replace it (see page 37).</td>
</tr>
<tr>
<td>🟢 paper flashing 🔴 ink flashing fast</td>
<td>The CD/DVD tray guide cover is open while printing from paper loaded in the sheet feeder. Remove the loaded paper to print on a CD or DVD or close the CD/DVD guide cover to print on paper (see page 31 to locate the CD/DVD tray guide cover). Press the 🟢 paper button to clear the error.</td>
</tr>
<tr>
<td>🟢 paper and 🔴 ink flashing or flashing alternately</td>
<td>An unsupported device is connected to the 🌐 external USB port. Connect only a PictBridge compatible digital camera to the 🌐 external USB port (see the on-screen Reference Guide).</td>
</tr>
<tr>
<td>🔴 power off 🟢 paper and 🔴 ink flashing alternately</td>
<td>Parts inside the R1900 Series are at the end of their service life or an unknown error has occurred. Contact Epson for help (see page 45).</td>
</tr>
<tr>
<td>🔴 power off 🟢 paper and 🔴 ink flashing fast</td>
<td>The print head is obstructed by paper or other foreign material. Turn off the printer, remove any obstructions, and turn it back on. If the error persists, contact Epson (see page 45).</td>
</tr>
</tbody>
</table>
Problems and Solutions

Check the solutions below if you’re having trouble using your printer.

**Printing Problems**

- Make sure your paper is loaded printable side up, short edge first, and against the right side with the edge guide against it (see page 6 and page 8).

- Don’t load paper above the arrow mark inside the sheet feeder edge guide. Load only one sheet of compatible paper using the single sheet guide (see page 8).

- Make sure the paper size settings in the printer software are correct for the paper you loaded.

- If the paper is flashing and printing has stopped, make sure the printer cover is closed. Leaving the printer cover open stops or prevents printing.

**Paper Feeding Problems**

- If paper doesn’t feed into the sheet feeder, remove it and flip through the stack to separate the sheets. Reload paper against the right side and slide the edge guide against it. Also, do not load too many sheets in the sheet feeder at once (see page 6) and make sure the printer cover is closed.

- If paper loaded using the single sheet guide doesn’t feed, make sure you installed the guide correctly and guided the paper all the way into the printer (see page 8). Also make sure the printer cover is closed.

- If roll paper doesn’t feed, cut the end of it straight across and uncurl the end by rolling it backwards, if necessary. Then reload the paper carefully (see page 10) and make sure the printer cover is closed.

- If paper is jammed, try the following, depending on how you’re printing:

  **Sheet feeder or manual feed slot:** Press the paper button to eject any jammed sheets, then open the printer cover and remove any paper jammed inside. Press the paper button again to clear the error, then reload paper.

  **Roll paper slot:** Cut off any printed roll paper or canvas media, then remove (see page 12) and reload (see page 10) the paper.
**CD/DVD Printing Problems**

- If the CD/DVD tray won’t load or jams in the printer, gently pull out the CD/DVD tray and press the paper button, if it is flashing. Reload the CD/DVD tray, making sure to insert the tray correctly in the tray guide and align the arrows (see page 31). Also make sure the printer cover is closed.

- If your image is not positioned correctly on the disc or does not cover the printable area correctly, you may need to adjust the printing position using the Epson Print CD software. See the on-screen Reference Guide for instructions.

- If ink smears on your disc, make sure you’re printing on ink jet-printable CDs or DVDs and that the surface of the disc is dry. Handle printed discs carefully and let them dry for 24 hours before inserting them in a drive. If necessary, you can adjust the print quality using Epson Print CD software. See the on-screen Reference Guide for instructions.

**Print Quality Problems**

- For the best print quality, use Epson papers (see page 13) and genuine Epson ink cartridges (see page 37).

- Load the paper printable side up (usually the whiter, brighter, or glossy side).

- Make sure your paper isn’t damp or curled.

- Use a support sheet with special paper (sheet feeder only) or load one sheet at a time.

- Make sure the type of paper you loaded matches the paper size and paper type settings in your printer software (see page 22).

- Remove sheets from the output tray as they eject. Let your prints dry separately for at least 12 hours before framing or placing in a protective sheet. If you need to stack them, place a sheet of plain paper between each print.

- If you notice light or dark bands across your printouts or they are too faint, you may need to clean the print head. Run the Auto Nozzle Check and Cleaning utility to automatically check and clean the print head (see page 34).

- If you notice jagged vertical lines, run the Print Head Alignment utility to automatically check and align the print head (see page 35).

- The ink cartridges may be low on ink. Check your cartridge status (see page 36) and replace cartridges, if necessary (see page 37).
Where To Get Help

Epson Technical Support

Internet Support
Visit Epson's support website at epson.com/support and select your product for solutions to common problems. You can download drivers and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Speak to a Support Representative
Before you call Epson for support, please have the following information ready:

■ Product name (Epson Stylus Photo R1900 Series)
■ Product serial number (located on the label in back)
■ Proof of purchase (such as a store receipt) and date of purchase
■ Computer configuration
■ Description of the problem

Then call:

■ U.S.: (562) 276-7296, 6 AM to 6 PM, Pacific Time, Monday through Friday
■ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday

Days and hours of support are subject to change without notice. Toll or long distance charges may apply.

Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON (800-463-7766).
Important Safety Instructions

Before using your R1900 Series, read and follow these safety instructions:

■ Be sure to follow all warnings and instructions marked on the R1900 Series.
■ Use only the type of power source indicated on the R1900 Series label.
■ Use only the power cord that comes with the R1900 Series. Use of another cord may cause fires or shock. Do not use the cord with any other equipment.
■ Place the R1900 Series near a wall outlet where the plug can be easily unplugged.
■ If you won’t be using the R1900 Series for a long period, unplug the power cord from the electrical outlet.
■ Always turn off the R1900 Series using the power button, and wait until the power light stops flashing before unplugging the printer or cutting off power to the electrical outlet.
■ Avoid plugging the R1900 Series into an outlet on the same circuit as a photo copier or air control system that regularly switches on and off, or on an outlet controlled by a wall switch or timer.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the R1900 Series, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the R1900 Series for sufficient ventilation. Do not block or cover openings in the R1900 Series case or insert objects through the slots.
■ Do not place the R1900 Series near a radiator or heating vent or in direct sunlight.
■ Do not use aerosol products that contain flammable gases inside or around the R1900 Series. Doing so may cause fire.
■ Place the R1900 Series on a flat, stable surface that extends beyond its base in all directions. It will not operate properly if it is tilted or at an angle.
■ Make sure the R1900 Series is at least 4 inches (10 cm) away from the wall.
■ Do not touch the flat white cable inside the R1900 Series.
■ Do not spill liquid on the R1900 Series.
■ Except as specifically explained in your documentation, do not attempt to service the R1900 Series yourself.
■ Unplug the R1900 Series and refer servicing to qualified service personnel under the following conditions: if the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped or the case damaged; if the product does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.
■ When storing or transporting the R1900 Series, do not tilt it, stand it on its side, or turn it upside down; otherwise ink may leak from the cartridges.

**Ink Cartridge Safety Instructions**

■ Keep ink cartridges out of the reach of children and do not drink the ink.
■ Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
■ Do not put your hand inside the R1900 Series or touch any cartridges during printing.
■ Install a new ink cartridge immediately after removing an expended one. Leaving cartridges uninstalled can dry out the print head and may prevent the R1900 Series from printing.
■ If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the R1900 Series. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area. Do not store the cartridge upside down.
Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser that the Epson printer covered by this limited warranty statement, if purchased and operated only in the United States or Canada, will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your Epson printer prove defective during the warranty period, please call the Epson ConnectionSM at (562) 276-7296 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson’s option, may be another model of like kind and quality. Epson’s liability for replacement of the covered printer will not exceed the original retail selling price of the covered printer. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. Using this product for continuous production or similar high duty purposes is not considered normal use; damage, maintenance or service from such use will not be covered under this warranty. This warranty is not transferable. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the Epson product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the Epson product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse,
abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

To find the Epson Authorized Reseller nearest you, visit our website at: http://www.epson.com.

To find the Epson Customer Care Center nearest you, visit http://epson.com/support.

You can also write to:
Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Declaration of Conformity

According to 47CFR, Part 2 and 15 for: Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: Epson America, Inc.
Located at: MS 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Ink jet printer
Model: B431A
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.